LENESANS Application Note

Renesas RA Family
QE for Capacitive Touch usage for IAR EWARM

Introduction

This document will demonstrate how to generate QE code for Capacitive Touch in e2 studio and copy the QE
code to IAR EW for ARM using Renesas RA Microcontrollers.

Target Device
Capacitive Touch Evaluation System for RA2L1 (RSSK RA2L1)

Operating Environment

IDE IAR Embedded Workbench for Arm version 9.20.2 or later
e? studio version 2021-10 is used for Capacitive Touch tuning and
code generation

Configuration Tool RA Smart Configurator (RA SC) v2021-10 and FSP v3.5.0
Toolchains GNU Arm Embedded Toolchain: 10.3-2021.10

(GNU ARM Embedded 10.3.1.20210824)
QE Renesas QE for Capacitive Touch v3.0.1

Note: Please download and install tools from the following URL in advance.

e Renesas QE download site:
https://www.renesas.com/software-tool/ge-tools-particular-applications

e FSP with e? studio installer download site:
https://github.com/renesas/fsp/releases

e |AR EW for ARM download site:
https://www.iar.com/products/architectures/arm/iar-embedded-workbench-for-arm

e?studio RA SC

FSP source generation and
Capacitive Touch project generation for
lAR EWARM

!

IAR EWARM

build

QE for Capacitive Touch

source generation

Figure 1. Configuration diagram when using QE for Capacitive Touch with IAR EWARM
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Renesas RA Family

QE for Capacitive Touch usage for IAR EWARM

1. Creating a project in e? studio

A project generation wizard is available in e? studio to generate an RA project with a project name and the
associated device and board, including board-level drivers.

Start the e? studio application and choose a workspace folder in the Workspace Launcher. To create a new

RA project, follow these steps:

1. Select File > New > C/C++ Project.
2. Select the Renesas RA: Renesas RA C/C++ Project template. Click Next to continue.

) New C/C++ Project | X

Templates for New C/C++ Project

Renesas RA

Renesas RA C/C++ Project
=== Create an executable or static library C/C++ project for Renesas RA.

N
@

< Back Finish Cancel

Figure 2. Template Selection

3. In the next dialog box, enter a project name and click Next.

Project name
Ll

Q Renesas RA C/C++ Project O x

Renesas RA C/C++ Project

Project Name and Location

I‘ RACapTouchExample I
Use default location
C\Users\Renesas\e2_studio\RA_workspace\RACapTouchExample Browse...
default

You can download more Renesas packs here

Y
@

< Back Finish Cancel

Figure 3. Project Name and Location
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Renesas RA Family

QE for Capacitive Touch usage for IAR EWARM

4. In the device selection dialog, enter device and tool information:
FSP version: 3.5.0

Board: RSSK-RA2L1

Device: Auto selected

Language: C

example, GCC ARM Embedded 10.3.1.20210824)
Debugger: J-Link ARM
Click Next to continue.

Toolchain version: Latest GNU Arm Embedded Toolchain approved for use with Renesas RA. (for

(B Renesas RA C/C++ Project

Renesas RA C/C++ Project

Device and Tools Selection

Device Selection

FSP Versiond | 2.5.0 )| G =

Board: RSSK-RA2L1 ~

Device: R7FAZL1AB2DFP

Language: { ®C O C++

Device Details

TrustZone
Pins
Processor

No
100
Cortex-M23

Toolchains
p——

Debugger

GNU ARM Embedded
ARM Compiler 6.17

J-Link ARM

10.3.1.20210824 v

@ < Back

Finish

Cancel

Figure 4. Create New Project for RSSK-RA2L1

5. Build Artifact Selection: Executable
RTOS Selection: No RTOS

Q Renesas RA C/C++ Project

Renesas RA C/C++ Project
Build Artifact and RTOS Selection

Build Artifact Selection RTOS Selection

® Executable [ No RTOS

* Project builds to an executable file

O Sstatic Library
* Project builds to a static library file

O Executable Using an RA Static Library
* Project builds to an executable file
* Project uses an existing RA static library project

@ < Back

Finish

Cancel

Figure 5. Build Artifact and RTOS Selection
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

6. In the project template dialog, select Bare Metal - Minimal and click Finish.

8} Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Project Template Selection |

Project Template Selection

o O' Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and
the C runtime environment.

[Renesas.RA.3.5.0.pack]

® *| Bare Metal - Minimal
Q Bare metal FSP project that includes BSR This project will initialize clocks, pins, stacks, and the C runtime environment,
[Renesas.RA.3.5.0.pack]

Code Generation Settings
Use Renesas Code Formatter

@ <Back Next > Cancel

Figure 6. Project Template Selection

7. Once complete, e? studio creates a new project with the “FSP Configuration” perspective open and ready
for project configuration.

{8 workspace - RACapTouchExample/configuration.xml - € studio - O X
File Edit Mavigate Search Project RenesasViews FRun Window Help
|7}$ Debug VHE RACapTouchExample Debug_Flat | - | ® - '%- ] Fiy~ % 8 &| ’tﬁ - Q-
L~ mwmEFDHSiH-~ X Yo "U Q @|E|CJC++ {5k FSP Configuration
Iy Project Explorer 52 | [E <§> ST RAC; mple] FSP Configuration X = B | FSP Visualizati &3 {3 Package = O
c
L=} RACapTuuchExamp\e Summary
[ Includes Generate Project Content
B £l o 22| 0|5 »
(& ra_gen Project Summary Renesas ~
2 sre
& raclg Board: RSSK-RAZL1
E’ “”F: ) ‘ Device: R7FAZL1AB2DFP
4
% configuration el Toolchain: GCC ARM Embedded
|= R7FAZL1AB2DFRpincfg R .
= Toolchain Version: 10.3.1.20210824 id
|= RACapTouchExample Debug_Flatlaunch . n
- F5P Version: 350
(7) Developer Assistance
Project Type: Flat
Selected software components
Board Support Package Common Files v3.5.0
110 Port v3.5.0
Arm CMSIS Version 5 - Core (M) v5.8.0+renesas.0fsp.35.0
Board support package for RTFAZL1AB2DFP  v3.5.0
Board support package for RA2L1 v3.5.0
Board support package for RAZL1 - FSP Data v3.5.0
RAZL1-RSSK Board Support Files v3.5.0 N7
Support ik =
Summary] BSP | Clnck5| Pins‘ Inlerrupl5| Event Link;| Sla(k5|CumpDnEnls| » Legend
[ Properties 12 |[#] Problems @ Smart Browser 48 =0 Eﬂ Pin Conflicts &3 T & =0
0 items
Description Module Pin Location
Properties are not available.
< >

Figure 7. New Project for RSSK RA2L1
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

2. Create Capacitive Touch Configuration in e? studio

1. If you have not installed the QE for Capacitive Touch, select Renesas Views > Renesas Software
Installer from the menu of e? studio to install it.

2. Inthe Renesas Software Installer dialog box, select Renesas QE, then click Next.

3. Select QE for Capacitive Touch and click Finish to install it.

&) Renesas Software Installer O X

Install Extensions ‘%

Select extensions to install, Press Finish to proceed with installation. u
Press the information button to see a detailed overview and a link to more

Find: | |

O QE for BLE[RA,RE] (v1.3.0)

Tools to assist in development work invelving Bluetooth?a Low Energy.

O QE for BLE[RX] (v1.1.0)

Tools to assist in development work invelving Bluetooth?a Low Energy.

QE for Capacitive Touch (v3.0.1)

Tools to assist in the configuration, tuning, and monitering of touch interfaces. (supports all
touch MCUs: RX, RA, RL78, and Renesas Synergy)

O  QE for Capacitive Touch[RX] (v1.1.0)

Tools to assist in the configuration, tuning, and monitoring of touch interfaces. (only
supports use with FIT medules V1.1 or before in RX family)

O QE for Display[RX] (v2.1.0)

Tools to assist with timing settings or the image quality of displays. (for use with display
controllers from Renesas)

O  QE for Motor (v1.0.0)

@ < Back Mext > Cancel

Figure 8. Install QE for Capacitive Touch

4. From the menu of e? studio, select Renesas Views > Renesas QE > CapTouch Main (QE) to open the
main perspective for configuring capacitive touch to the project.

&) workspace - e studio

File Edit Navigate Search Project Run  Window Help
¥ Debug Je * hug Fat il |~ &~
Fiy - v i '

Debug >
¥ Ui E | Partner OS »
=] <='|=€> l? 8 Pin Configurator > P Configuration &3
=5 RACapTouchExample I Renesas QF > Ib CapTouch Gesture Menitor (QE)
Solution Toolkit ¥ b CapTouch Board Monitor (QE) 9
Tracing > CapTouch Pad Meonitor (QF)
#  Renesas Software Installer I-g_(:amin (QE) =
[ Board: Eg. CapTouch Multi Status Chart (QE)
Device: b CapTouch Parameters (QE)
Toolchain: % CapTouch Status Chart (QF)
Toolchain Version: iz Measuring Current Consumption (QE)
FSP Version: T

Figure 9. Open CapTouch Main (QE)
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Renesas RA Family

QE for Capacitive Touch usage for IAR EWARM

5.

pull-down tab and selecting the RACapTouchExample project as shown below.

In the CapTouch Main (QE) pane, select the project to configure the Touch interface for by using the

8} [RACzpTouchExample] FSP Configuration

‘Warkflow Diagram
1. Preparation S

Prepare a project that uses the touch
interfaces,

To Select a Project

Select the target project.

RACapTouchExample

Select or create a touch interface
configuration.

Vlodify Configuration

D

2. Tuning 3 3. Coding

QE will automatically perform tuning
processing for each touch sensor,

Implement a program using the touch
interfaces.

To Connect Target Board To Show Code

Connect your target board and PC via Implement a program that perladically

an emulatar. scans the status of the touch senser in
the main(} function

To Start Tuning

Follow instructions in the dialog. oy S =
Start Tuning

[JEnable advanced tuning

To Output Parameter Files
Output parameter files from a tuning
result.

Output Parameter Files
[ Specify an output folder
[ Use an external trigger

[ Use diagnostic code

Use API compatibility mode

4. Monitoring )
L}

You can check a behavior of touch

interfaces and make fine adjustments.

To Launch Debug (via Emulator
Launch debugging for your target
project and execute the program.

To Connect UART

Enable a monitoring function via serfal
sommunication, if you do not use an
emulator,

Baudrate [ 115200

Port Auto v

Connect
To Enable Monitoring

Shi onitoring views and enable a
manitoring function.

Show Views

Figure 10. Select Project

6. Create a new Touch configuration by using the lower pull-down and selecting Create a new

configuration.

_?_‘3“,} [RACapTouchExample] FSP Configuration

Warkflow Diagram

1. Preparation IS
Prepare a project that uses the touch
interfaces.

Select the target project.
RACapTouchExample w
To Prepare a Configuration

Select or create a touch interface
configuration.

Create a new confisuration

D

2. Tuning =) 3. Coding

QE will automatically perform tuning
processing for each touch sensor.

Implement a program using the touch
interfaces,

To Connect Target Board To Show Code

Connect your target board and PG via Implement a program that perladically

an emulator. scans the status of the touch sensor in
the main(} function

To Start Tuning

Follow instructions in the dialog. Show Sample
Show Samp
Start Tuning

[JEnable advanced tuning

To Output Parameter Files }
Qutput parameter files from a tuning
result.

Output Parameter Files
[ Specify an output folder
[ Use an external trigger

[ Use diagnostic code

Use API compatibil

4. Monitoring

You can check & behavior of touch
interfaces and make fine adjustments.

To Launch Debug (via Emulator
Launch debugging for your target
project and execute the program.

To Connect UART

Enable a menitoring function via serial
communication, if you de not use an
emulator.

Baud rate | 115200

Port Aute %

Connect

To Enable Mo: ng
Show monitaring views and enable a
manitoring function.

Show Views

Figure 11. Create New Touch Configuration
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

7. A new menu window will open with the default blank canvas for creating the Touch Interface.

| 8B Create Canfiqueation of Touch Interfaces *
File Mame of Touch VF: RACapTouchEsampie Setup Canfiguration impart { Rie-ecit
Descriptian: |
4 N\ ok IF

Capacitance Type
Self Capacitance v
Butten

Shder (honzontal)
Shcler (vertical)
Wheel

Key pad

Shield Pin
TC Pin

Capacitan e Semser

Sething Rermave Touch UF

Setup Resistance Value Clear Assagred TSx

Figure 12. Blank Canvas

8. Add 3 buttons to the canvas by:
a. Selecting the Button menu item from the right-hand side and moving the mouse onto the canvas.
b. Click the left-hand mouse button to drop the button icon. Do this three times to add three buttons.
c. Pressthe ESC key to exit once the three buttons are added.

{8 Create Configuration of Touch Interfaces s
File Name of Touch I/F: RACapToL mple Setup C i Import / Re-edit
Description:

Touch I/F
Capacitance Type
Bitent0 Self Capacitance v
J Slider (horizontal)
Button01
Slider (vertical)
Wheel
Buttono2 Key pad
3D Gesture (Al)
Touch pad
Shield Pin
TC Pin
Capacitance Sensor

Current Sensor

Diagnosis Pin

Setting Remove Touch I/F

Setup Touch I/F Setup Resistance Value Clear Assigned TSx

€3 There are some problems with setting.

Figure 13. Create New Touch Button
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

9. Assign Touch Sensor to buttons:

a. Double click on Button00 and a dialog box will appear. Rename it to TS_B1. Using the pull-down
and select TS11 as the MCU sensor to assign to this button.

b. Double click on Button01 and a dialog box will appear. Rename it to TS_B2. Using the pull-down
and select TS10 as the MCU sensor to assign to this button.

C.

Double click on Button02 and a dialog box will appear. Rename it to TS_B3. Using the pull-down
and select TS09 as the MCU sensor to assign to this button.

{8} Setup Touch Interface hed

Button(self)

Mame || T5_B1 I

Touch Sensor Resistance[chm]
l 511 l« 560 v

Figure 14. Assign Touch Sensor to Button

10. Select the Wheel menu item from the right-hand side and add it onto the canvas. Press ESC once
completed.

11. Double click on Wheel00 and a dialog box will appear. Using the pull-down and select TS21, TS18,
TS32, TS23 as the MCU sensors to assign to this wheel.

& Setup Touch Interface ped
‘Wheel
Mame |Whee\l]]
Number of Touch Sensor |4 v
Touch Senser Resistance[chm]
TS21 560
T518 560
T832 560
TS23 v 560 v
Reverse

Figure 15. Assign Touch Sensor to Wheel

12. Selecting the Slider (horizontal) menu item from the right-hand side and add it onto the canvas. Press
ESC once completed.

13. Double click on Slider00 and a dialog box will appear.
a. Select Number of Touch Sensor: 5.

b. Use the pull-down and select TS06, TS07, TS05, TS02, and TS04 as the MCU sensors to assign to

this slider.

{8} Setup Touch Interface X
Slider
Name | Slideroo ‘
Number of Touch Sensorl 5 I v
Touch Sensor Resistance[ohm]
TS06 560
TS07 560
TS05 560
Ts02 560
Ts04 v 560 v

Reverse
Gnce Hetp

Figure 16. Assign Touch Sensor to Slider
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

14. Select the Shield Pin menu item from the right-hand side.
a. Add the 1st shield to the canvas to cover the three buttons.
b. Add the 2nd shield to the canvas to cover the wheel.
c. Add the 3rd shield to the canvas to cover the slider.
d. Press ESC once completed.
15. Assign Touch Sensor to shields.
a. Double click on Shield00 and a dialog box will appear. Assign TS00 to this shield.
b. Double click on Shield01 and a dialog box will appear. Assign TS14 to this shield.
c. Double click on Shield02 and a dialog box will appear. Assign TS08 to this shield.
16. This completes the addition of the Touch interface like shown below Figure 17.

(B Create Configueation of Touch Interfazes x

RACspTouchExample Setup Configuration Impoet / e-edit

Shieldan, T514

Whesloo

sn Button
Shefer (harrontal )
T8 Tt TS B2
Sliser {vertical
0 Whes!
S ™R
54 Ky pad
T53
Shuckd0, T508
S Shield P
TCFin
Tooe, TS0 Tois TSor Tso4,
5 i Capacitance Sensor
Setting Remave Touch UF
Setup Resistance Value Clear Assigned TSx

== e

Figure 17. Complete New Touch Interface

17. Next, set the touch interface configuration. Press Setup Configuration button to open the Setup
Configuration (methods) dialog and set the three active shields.

a Create Configuration of Touch Interfaces 9 Sc‘lup Cnnﬁguraliuns {Mdhods] »
File Mame of Teuch |/F: RACapTouchExample ]
- . Add Configuration| Remove Configuration
Description:
[ | configot

TS_B1{self) Available
T5_B2(self) Available
TS_B3(self) Available
Wheel00{self) Available
SliderD0{self) Available
Shield00(self) Available
ShieldD1(self) O
Shield2(self) O

Figure 18. Setup Configuration
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

18. The following steps to configure like Figure 19.

a.

b.
c.

Uncheck Wheel00(self) and Slider00(self) to compose Shield00(self) with TS_B1(self),

TS _B2(self) and TS_B3(self) as config01.

Press Add Configuration, config02 is added.

Uncheck TS_B1(self), TS _B2(self), TS_B3(self), Slider00(self), Shield00(self) and Shield02(self)
to compose Shield01(self) with Wheel00(self) and Shield01(self) as config02.

Press Add Configuration, config03 is added.

Uncheck TS_B1(self), TS_B2(self), TS_B3(self), Wheel00(self), Shield00(self) and Shield01(self)
to compose Shield02(self) with Slider00(self) and Shield02(self) as config03.

Click OK to close the dialog box.

g Setup Configurations (Methods) x

Add Configuration | | Remove Configuration

O |cc>n"ig01 | ] | configl2 ‘ I |cc>n"ig03
- A’
TS_B1(self) Available O O
TS_B2(self) Available O O
TS_B3(self) Available O O
Wheel00(self) O Available O
Slideroo(self) O O Available
Shield0o(self) Available O O
Shieldo1(self) | Available 1
Shieldo2(self) | O Available
\ v,

Gna [ Hep

Figure 19. Setting Setup Configurations (Methods)

19. This is the final Touch Interface. Click Create button bottom right of the Configuration of Touch
Interfaces window to set up the Touch Interface.
20. The CapTouch Main (QE) will now display the configuration of the touch interface in the main view pane.

Touch IfF Configuration: RACapTouchExample

Method  Kind Name Touch Sensor Parasitic Capacitance[pF] = Sensor Drive Pulse Frequency[MHz]  Threshold  Scan Time[ms] = Owverflow *
configol  Button(self) TS_B1 T511 - - - - Mone
configdl  Button(self) TS_B2 T510 - - - - None
configol  Button(self) TS B3 T509 - - - - None
configdl  Shield Electrode Pin -~ Shield0d  TS00 - -
configd2z  Wheel Wheelod  TS21, TS1g 7532, TS23 - - - - Mone
configdz  Wheel TS (Wheeloo) TS21 - -
configd2z  Wheel TS (Wheelo) T518
configdz  Wheel TS (Wheeloo) TS32
configd2z  Wheel TS (Wheelon)  TS23
configd2  Shield Electrode Pin -~ Shield01 T514 - -
configdd  Slider Slider0n TS06, TS07, TS05, TS02, TS04 - - - - - Mone
configo3  Slider TS (Sliderog)  TS06
configd3  Slider TS (Slideroo) 7507
configo3  Slider TS (Slideroo)  TS05
configd3  Slider TS (Slideroo)  TS02
configo3  Slider TS (Slideron)  T504

\_confia03 Shield Electrode Pin _ Shield02  TS08 - - - - - v

Figure 20. Main View Pane Displays the Touch Configuration
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Renesas RA Family

QE for Capacitive Touch usage for IAR EWARM

21.

Build the project by clicking the hammer icon. The project should build without any errors or warnings.

&F workspace - & studio

File Edit Search Project Renesas Views Run

7 Debug

4

MNavigate

[ Pin Conflicts -

Window |
[£7 RACapTouchExample

X| & 5|5 CBRE = B

ICDT Build Conscle [RACapTouchExample]

14:14:58 Build Finished.l @ errors, @ warnings.l (took 8s.294ms)

Figure 21. Build Project

3. Capacitive Touch Tuning in e? studio

Connect the board with a PC. Refer to the Figure 53 for how to connect.

2. To start the automatic tuning process, click the button Start Tuning in the CapTouch Main (QE).

1. Preparation & 2. Tuning 3. Coding

Prepare a project that uses the touch QE will automatically perform tuning Implement a program using the touch

interfaces. processing for each touch sensor. interfaces,

To Select a Project To Connect Target Board To Show Code

Select the target project. Connect your target board and PC via Implement a program that periodically
an emulator. scans the status of the touch sensor in

RACapTouchExample . the main(} function.
P a v To Start Tuning
Fallow instructions in the dialog. - -
Show Sample
To Prepare a Configuration .
Select or create a touch intarface I Start Tuning I

configuration.
E [JEnable advanced tuning

REpEmEE ey |y } To Output Parameter Files } ’
Qutput parameter files from a tuning
Medify Configuration result.

Output Parameter Files
[ 5pecify an output folder
[JUse an external trigger

[ Use diagnostic code

Use API compatibility mode

4. Monitoring

===
3
L)

fou can check a behavior of touch
interfaces and make fine adjustments.

To Launch Debug (via Emulator)
Launch debugging for your target
project and execute the program.

To Connect UART

Enable a monitoring function via serial
communication, if you do not use an
emulator,

Baud rate | 115200

Port Auto Y]

Connect

To Enable Monitoring
Show menitoring views and enable a
monitoring function.

Show Views

Figure 22. Start Tuning
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

3. At the start of the first debug session, e? studio may display a message indicating that is will switch to the
Debug perspective. Click the Remember my decision check box and Switch to continue the Debug
process and the QE for Capacitive Touch automatic tuning.

Q Confirm Perspective Switch X

'o This kind of launch is configured to open the Debug perspective when it suspends.
o/

This Debug perspective supports application debugging by providing views for displaying
the debug stack, variables and breakpoints.

Switch to this perspective?

Remember my decision

T

Figure 23. Switch Perspective

4. The QE for Capacitive Touch RA automatic tuning will now begin. Please read the tuning dialog windows
carefully as they will guide you through the tuning process. An example screen is shown below.
Typically, no interaction is required during the initial tuning process steps.

ﬁ Automatic Tuning Processing >

1/14: QE is beginning the tuning process.
During the tuning process, please do not touch the sensors on the target board
until instructed by the QE Tuning Program.

Figure 24. Tuning Dialog Window

5. After several automated steps, you will arrive at the dialog box with information like what is shown below.
This is the Touch sensitivity measurement step of the tuning process. Press using normal Touch
pressure on the sensor being indicated in the dialog box (TS_B3, TS09). When you press, the bar graph
will increase to the right and the Touch counts go numerically up. While holding that pressure, press any
key on the PC keyboard to accept the measurement.

Q Automatic Tuning Processing >

7/14: QE will now measure touch sensitivity for (TS_B3, TS09 @ config01).
In this step please use normal touch pressure on the sensor for once. Press any
key on the PC keyboard to accept the sensitivity measurement.

TS_B3, TS09 @ config01: 6139

Figure 25. Measure Touch Button TS_B3
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

6. Repeat the process for buttons TS B2 and TS_B1.

ﬁ Automatic Tuning Processing

8/14: QE will now measure touch sensitivity for (TS_B2, TS10 @ config01).
In this step please use normal touch pressure on the sensor for once. Press any

key on the PC keyboard to accept the sensitivity measurement.

TS_B2, TS10 @ config01: 6074

Figure 26. Measure Touch Button TS_B2

7. Next, we will measure the sensitivity of the wheel. Move your finger across the wheel sensors 3-4 times.
After that, press any key on the PC keyboard to accept the measurement.

ﬁ Automatic Tuning Processing

11/14: QE will now measure touch sensitivity for all wheels in this configuration

(config02) on the target board.
Please move your finger across all of the wheel sensors 3-4 times using normal

touch pressure. When complete, press any key on the PC keyboard to complete
the sensitivity measurement.

Figure 27. Repeat Measurement 3 Times

8. Next, we will adjust the slider. Move your finger across the slider 3-4 times. After that, press any key on
the PC keyboard to accept the measurement.

ﬁ Autematic Tuning Processing

13/14: QE will now measure touch sensitivity for all sliders in this configuration

(config03) on the target board.
Please move your finger across all of the slider sensors 3-4 times using normal

touch pressure. When complete, press any key on the PC keyboard to complete
the sensitivity measurement.

Figure 28. Repeat Measurement 3 Times
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Renesas RA Family

QE for Capacitive Touch usage for IAR EWARM

9. Once complete, you will see a screen like what is shown below. This is the detection threshold that is
used by the middleware to determine if a Touch event has occurred.

& Autematic Tuning Processing

*

The automatic tuning process is now complete. If overflow or warning/errors are
indicated, those sensors can be retried. If there are continued overflows or
warning/errors, please consult the Renesas application notes for Capacitive Touch
for guidance.

Select the target

OO00o0d

-~

Method

configi
configi
configi
configl2
configd3

Kind
Button
Button
Button
Wheel
Slider

Mame
TS B1
TS B2
TS B3
Wheel00
Slider00

Touch Sensor
T511
T510
Ts09

TS21, TS18, TS32, 1523
TS06, TS07, TS05, T502, TS04

Threshold
387

379

288

389

1312

Overflow  Warning,

Fetry | Continue the Tuning Process

Figure 29. Threshold for Touch Event

10. Click the Continue the Tuning Process button in the dialog box shown. This will exit the tuning process
and disconnect from the Debug session on the target. You should return to the default CapTouch Main
(QE) screen in the e? studio IDE.

Lugu pueun

figd1 Button

I Continue the Tuning Processl

Figure 30. Continue the Tuning Process

11. After the tuning process is completed, the default view of the CapTouch Main (QE) presented here will
be the results of the tuning process for the sensors in the configuration. This gives the user a quick way
to examine the tuning results.

Tuning  Gesture

Touch I/F Configuration: RACapTouchExample
Method  Kind Mame Touch Sensor Parasitic Capacitance[pF] Sensor Drive Pulse Frequency[M...  Thresheld  Scan Time[ms] Chverflow &
configdl  Button(self) TS B1 T511 6.58 1.0 397 0.576 Mone
configdl  Button(self) TS B2 T510 7.528 1.0 379 0.576 Mone
configdl  Button(self) TS B2 TS09 575 1.0 288 0.576 Mone
configd1  Shield Electrode Pin - Shieldoo  T500 25,972 -
configi2z  Wheel Wheeloo  TS21, TS18, 7532, TS23 - 389 - Mone
configiz  Wheel TS (Wheeloo) TS21 6424 1.0 0.576
configiz  Wheel TS (Wheeloo) TS18 6431 1.0 0.576
configiz  Wheel TS (Wheeloo) TS32 6.09 1.0 0.576
configiz  Wheel TS (Wheeloo) TS23 6.562 1.0 0.576
configd2  Shield Electrode Pin  Shield01 T514 23.979 -
configd3  Slider Slider00 TS06, TS07, TS05, TS02, TS04 - 1312 Mone
configd3  Slider TS (Slideroo)  TS06 575 1.0 - 0.576
configd3  Slider TS (Slideroo)  TS07 5.792 1.0 0.576
configd3  Slider TS (Slideroo)  TS05 5.382 1.0 0.576
configd3  Slider TS (Slideroo) TS0z 4.764 1.0 0.576
configd3  Slider TS (Slideroo) ~ TS04 5.806 1.0 0.576
config03  Shield Electrode Pin_ Shieldoz 7508 25.326 &

Figure 31. Tuning Result
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

12. Finally, output the tuning parameter files. Click the button Output Parameter Files.

} To Output P§rajneter Files )
Qutput paramg iles from a tuning
result.

Output Parameter Files

Figure 32. Continue The Tuning Process

13. Look at the Project Explorer window and you will see that files have been added. These contain the
needed tuning information to enable Touch detection using the r_ctsu and rm_touch FSP modules.

91;—? Binaries
o Includes
w [ ge_gen
[£] ge_touch_config.c
[ ge_touch_config.h
[R] ge_touch_define.h

[ = .

Figure 33. Output Parameter Files

4. Creating a project in IAR EWARM

1. Install the IAR Embedded Workbench for ARM version 9.20.2 from
https://www.iar.com/products/architectures/arm/iar-embedded-workbench-for-arm.
2. Install the RA Smart Configurator (RA SC) from https://www.renesas.com/smart-configurator.

Note: Please check the version of the RA Smart Configurator installer. If the FSP is not v3.5.0, download
and install the latest version from https://github.com/renesas/fsp/releases.

3. To create a third-party IDE project with the RA Smart Configurator, run the “rasc.exe” application. In the
“New Renesas RA FSP Project” wizard, enter the Project name and Location.

E MNew Renesas RA F5SP Project

New Renesas RA FSP Project

Project Name and Location

Project name

IAR_OFCapTouchExampld

Location: | C\Users\Renesas\|AR\workspace Browse...

You can download more Rengsas packs here

Figure 34. Project Name And Location
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4. Board: RSSK-RA2L1

€ Mew Renesas RA FSP Project m} X
New Renesas RA FSP Project
Device and Tools Selection
Device Selection
FSP Version: |3.5.0 ” Board Description
Board: IRSSI(-RAZU ~ I
Device: R7FAZL1ABZDFP
Language: ®C OC++ Device Details
TrustZone Mo
Pins 100
Processor Cortex-M23
IDE Project Type
AR EWARM Version 8 ~
Teclchains
|AR Toolchain for ARM
< Back Finish Cancel
Figure 35. Board Selection for RSSK RA2L1
5. RTOS Selection: No RTOS
E Mew Renesas RA FSP Project m] b4
MNew Renesas RA FSP Project
RTOS Selection
| RTOS Selection
No RTOS | v
|
< Back Bt > igh Cancel
Figure 36. RTOS Selection

R20AN0611EJ0110 Rev.1.10
Jan.25.22

Re Page 17 of 31
KENESAS



Renesas RA Family

QE for Capacitive Touch usage for IAR EWARM

6. Project Template Selection: Bare Metal —

Minimum. Click Finish to create project.

IE Mew Renesas RA FSP Project

New Renesas RA FSP Project

Project Template Selection

O x

Project Template Selection
o Q' Bare Metal - Blinky

the C runtime environment.
[Renesas.RA.2.5.0.pack]

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and

Minimal

® @' Bare Metal -

[Renesas.RA.2.5.0.pack]

Bare metal FSP project that includes BSP This project will initialize clocks, pins, stacks, and the C runtime environment.

< Back Next >

Cancel

Figure 37. Template Selection

7. After the project is created, the DDSC Smart Configurator window will pop-up.

ﬁ DDSC Smart Cenfigurator
Help Run
{5 [1AR_QECapTouchExample] FSP Configuration 52

Summary

Project Summary

Board: RSSK-RAZ2L1
Device: RTFA2L1AB2DFP
FSP Version: 350

Project Type: Flat

Selected software components

v35.0
v3.5.0

Board Support Package Common Files

10 Port

Arm CMSIS Version 5 - Core (M)

Board support package for RTFA2L1AB2DFP
Board support package for RA2L1

Board support package for RA2L1 - FSP Data
RA2L1-RSSK Board Support Files

v3i50
v3is0
v3is50
v35.0

E.

v5.8.0+renesas.0.fsp.3.5.0

| Summary | BSP | Clocks | Pins| Intermupts| Event Links | Stacks | Components

[T Properties [2] Problems

Properties are not available,

- [m] x
= B % FSPVisualization 5] Package =g
Generate Project Content Lijaj22)8B]8 s
RENESAS
R
> H#

F4 8 = O [5PinConfiicts El Console ¥ i =B

0items
Description . Module Pin Location
< >

Figure 38.

Smart Configurator Window
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

8.

Navigate to the project location in Windows Explorer and double-click on the main workspace (IAR
EWARM * _eww file) to open the project.

| ) 5 | workspace - O X
Home Share View v o
&« v 4 » ThisPC » OS(C) » Users » Renesas » IAR » workspace v [S] £ Search workspace
> 5 Quick access Name Date modified Type Size
> Il Desktop .settings 12/3/2020 4:15 PM File folder
ra 12/3/2020 4:15 PM File folder
ra_cfg 12/3/2020 4:15 PM File folder
ra_gen 12/3/2020 4:15 PM File folder
script 12/3/2020 4:15 PM File folder
L src 12/3/2020 4:15 PM File folder
D buildinfo.ipcf 12/3/2020 4:15 PM IPCF File
|1 configurationxml 12/3/2020 4:15 PM XML Document
[ ] 1AR_QECapTouchExample.ewd 12/3/2020 4:15 PM EWD File 1
D IAR_QECapTouchExample.ewp 12/3/2020 4:15 PM EWP File
Ie IAR_QECapTouchExample.eww I 12/3/2020 4:15 PM IAR IDE Workspace
D R7FA2L1AB2DFP.pincfg 10/30/2020 1:35 AM PINCFG File
£

12 items

Figure 39. Project Location

The project is opened by IAR EWARM. Right-click on the project and select Rebuild All. The project
should be built without error.

Eile Edit View Project ik Tools Window Help
00 S = X RO

betug

Files o .

=l
|1 8 Flex Software
{=) 8 Build Configuration
& uE Components
& Generated Data.
] W8 Program Entry
[ buildinfo.ipef
Lo i Output
[B 14R_OECspTouch..
DaR_OECapTouch..

| 1&R_QECapT ouchE xampie
oY vax

Messages File Line =
Linking

I Total number of ermors: 0 I

T 3

< i >

Build DebugLog

Figure 40. Project is Built Successfully

10. After a project created with the RA Smart Configurator has been opened in IAR EWARM, its FSP

configuration can be changed by relaunching the RA Smart Configurator from the IDE. Follow the
instructions below to reopen the RA Smart Configurator.
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11. In the menu of IAR EWARM, select Tools > Configure Tools... Then, select New and fill in the fields as
follows.
Menu Text: RA Smart Configurator
Command: Select “Browse...” and navigate to “rasc.exe”
Argument: -compiler IAR configuration.xml
Initial Directory: $PROJ_DIR$

Configure Tools

Menu Content:

R, Smart Configuratar

Cancel

New

Delete

benu Text:

| R Smart Canfiguratar |

Command:

| CARenesas\Ratsc_v2021-10_fsp_v3 5.0\eclipsetrasc.exe | Browse...

Argument;

| -compiler &R configuration, xml |

Initial Directory:
|$F'F|DJ_DIH$ |

[ Redirect to Dutput Window
[ Prampt for Command Line
Tool &vailable:

Always e

Figure 41. How to Use RA Smart Configurator in IAR EWARM
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12. Now, a FSP configuration of a created project can be reopened by select Tool > RA Smart
Configurator in IAR EWARM.

File Edit View Project J-link [Tools | Window Help

‘DO W@ = X W[ ® optons.

Workspace v X Filename Extensions...
|Debug ~ Configure Viewers..,
Files 3 Configure Custom Argument Variables..,

2 ®IAR_QECapTouc... + 4 | Configure Tools...
=1 8 Flex Softwars _
B Build Configura... IAR Project Converter
| = Componsnis RA Smart Configurator

| B Generated Data

| B Program Entry
L— Dbuildinfo.ipct

I 18R_OECapT ouchE xample

Figure 42. RA Smart Configurator Has Been Added

5. Adding TOUCH Driver in IAR EWARM

1. In Smart Configurator, select the Pins tab at the bottom of the pane. Type ctsu in the search box and
select the CTSUO pin in the search result.

Pin Configuration 0
Generate Project Content
Select Pin Configuration ﬁ Export to C5V file Configure Pin Driver Warnings
|RSSK-RA2L1 v| Manage configurations...

[~] Generate data: | g_bsp_pin_cfg |

Pin Selection &= 1% Pin Configuration I“Q Cycle Pin Group

Ictsu| xl MName Value Link

w « Peripherals

R [ Ta 1 L

Pin Function | Pin Number

Summary | BSP | Clocksl Pins Ilntenupis| Event Links | Stacl:s| Components|

Figure 43. Select Pin CTSUO
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2. Ensure that the Operation Mode and the TS pins below are enabled:
TSCAP, TS00, TS04, TS05, TS06, TS07, TS18, TS21, TS23, TS02-CFC, TS08-CFC, TS09-CFC,
TS10-CFC, TS11-CFC, TS14-CFC, and TS32-CFC.
. . . [y
Pin Cnnflguratlun Generate Project Content
Select Pin Configuration m Export to C5V file Cenfigure Pin Driver Warnings
|RSSK-RA2L1 v | Manage configurations...
[] Generate data: |g_bsp_pin_cfg |
Pin Selection &= 2 |8, Pin Configuration ~ 1 Cycle Pin Group
cteu x | Mame Value Lock  Link
~ " Peripherals IOpe:E]Dr; M':de Enabled
X o [ullall) LITEL
v ?pé%cﬁu (" Tscap v P112 & =
TS00 + P204 Bl =3
TS02-CFC + P303 B =3
TS04 + PAD3 B =
TS05 « PADG T =
TS06 « P40 & (=3
TS07 < P41 il £
TS08-CFC ¥ P302 & =)
TS09-CFC « P30T &l =3
T510-CFC + P109 B =
\_ T511-CFC + P110 JL & =
T512-CFC « P111 B =3
I513-CEC piod &ﬂ?' =3
T514-CFC « P102 I & =5
TST5-CFC POz i =3
T516-CFC « P101 &l =3
1517 pap3 i =3
TS18 ¥ P02 i =
T521 + POOD B =)
527 P01 & =3
7523 v POD2 |
TSoT g B o
Ts25 + P04 B =
TS26-CFC + P100 B =
T527-CFC < P1132 a =)
T528-CFC « P015 &l =3
TS29-CFC < P114 B =)
TS30-CFC + PO10 B =
TS CEC poid &ﬂ?' =3
T532-CFC « PO12 I B =
TS33-CFC IE: B =
TS34-CFC + P105 B =3
T$35-CFC « P13 & (=3
£ >
Module name:  CTSUO
Pin Function | Pin Number|
Summary | BSP |Clocks M Interrupts| Event Links| Stacks| Components|
Figure 44. Enable TS Pins for RSSK-RA2L1
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

3. Move to the Stacks tab. Add the Capacitive Touch middleware by clicking New Stack > CapTouch >
Touch (rm_touch).

Stacks Configuration

Generate Project Content e

LNENE NN ED
Threads &) MNew Thread 3] Rermnove HAL/Common Stacks &) New Stack > |2 Extend Stack > g5 Rermowe
v & HAL/Common — Analeg >
47 g ioport 1/O Port (r_ioport) & g_ioport I/0 Port Artificial Intelligence >
(r_ioport) .
Audic >
>

@® Bootloader

Connectivity
DsP

Input
Menitoring
Motor
Metwerking

Objects &) Mew Object > 3] Remove P
Security

Sensor
Storage
System
Timers
Transfer

L Y ]

Summary | BSP ‘ Clocks ‘ Pins ‘ Interrupts | Event Linksl Stacksl Components » Legend
@ Pin Conflicts & Console /§ Search... ? § = g

Figure 45. Add TOUCH Driver

4. Clickonthe generate p,?m contens DUttON to generate the source files.

5. In IAR EWARM, right-click on the project and select Rebuild All. The project should be built without
error.

File Edit View Project J-link Tools Window Help

+ o

AR X

Workspace v o1 X
Debug -
Files &

Sl JIAR_QECapTouc...| v |
£ 8 Flex Software

Ml Build Configura...

| B Companants

| M Generated Data

| M Program Entry

F— Dlbuildinfo.ipcf

B Cutput

14R_OECapT ouchE xample

Build i
Messages File Line *
hal_entry.c
hal_data.c
main.c

4R _QECapTouchExample.out

| Total nurmber of errors: 0 I

Build succeeded

Build Debuglog

Ready Errors 0, Warnings 0 CAP NUM OvR BEE ¢

Figure 46. Fix Errors
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6. Copying QE files to IAR EWARM
1. Copy the ge_gen folder in e? studio and paste it to the IAR EWARM project folder.

& Project Explorer & BR®% §°=8
~ &% RACapTouchExample [Debug]

>
A = | workspace

~|&" ge_gen _
Home  Share ew
» & ge_touch_config.c = b
>[5 ge_touch_config.h T = 1AR » workspace v B

> di ge touch define h

ey > s Cuick sccess MNarme
> @ ra_gen ::t:ng"
0
> @ src
» & Debug I -
» & QE-Touch e
EN ra_clg ra_gen
» & seript seript
i configuration.xml settings
14 RTFAZL1AB2DFP pincfg 51
W ra_cfg.txt | budinfo.ipef

1 RACapTouchExample Debug_Flatlaunch
» (@ Developer Assistance

| configuration xmi
| 1AR_QECapTouchExample.custom_argvars

O Properties ! Problems = @& Smart Browser 19 items

- a x
S Search workspace
Date madified el
12/3/2020 415 PM
2020 420 PM

12/4/2020 2:28 PM
124472020 2:28 PM

Figure 47. Copy ge_gen Folder To IAR

2. In IAR EWARM, right-click on the project name and select Add > Add Group.... Enter the group name

ge_gen and click OK.

File Edit View Project J-Link Tools Window Help

Debug
Files &+

=L JIAR_QECapTo
1 6 Flex Software
B Build Confic  pyake

B Component

W Generated “ampils
B Program Er Rebuild All

— @buildinfo.ipm‘ Clean
H Output

Options...

C-5TAT Static Analysis >

Stop Build

I Add

-

Add Files...

Add Group...

Remove

=

Rename...

Version Control System >

Add Group - IAR_QECapTouchExample X

Group name: 1
I—% “DK
| ge_gen :

Open Containing Folder...

Cancel

File Properties...

Set as Active

Figure 48. Create New Group
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3. Right-click on ge_gen group and select Add > Add Files.... Select all the source files inside the
ge_gen folder and click Open to add them to the project.

File Edit View Project J-link Tools Window Help

NN R = XKD C

‘Waorkspace v 0 X
Debug “
Files o

= @W1AR_QECapTouc...
B Flex Software

— =
— D buildinfo.ip
H Cutput

|
Options...

Make
Compile
Rebuild All

Clean
C-STAT Static Analysis >

Stop Build

Remove

Rename...
Version Control System >

Open Containing Folder...
File Properties...

Set as Active

© Brovse X
“ v 4 « Renesas » IAR » workspace » ge_gen v O 2 Search ge_gen
Organize = Mew folder Exe @ o
Ma - Date oy fwwl Foo
| qe_touch_config.c 1/18/2022 3:45 PM C File 18K
] qe touch_configh 1/18/2022 3:45 PM HFile I
| ge_touch_define.n 1/18/2022 3:45 PM H File: KB

File name: “qe_touch_define.h "qe.touch_config.c” "qe.touch_c: | | Saurce Files (. "cpp; " "h |

Cancel

Figure 49. Add Source Files

4. Right-click on the project name and select Options.... In the Options dialog, select C/C++ Compiler >

Preprocessor. Click on the [...] button to add include directory.

File Edit View Project J-link Tools Window Help

@ 14R_ QFCapTouchExample - IAR Embedded Workbench IDE - Arm 8.50.9

Options for node "IAR_QECapTouchExample” o

Factory Settings
| Multi-file Compdation
Dizcard Urased Publics
MISRAC: 1998 Encodings Extra Options
L 1 1 2 Code Op Output
List | Preprocessor l Diagnostics MISRA-C: 2004
[Jignore standard include directones |

| SPROJ_DIRS/ralanmm/CMSIS_5/CMSIS/Corelincude
|$PROJ_DIRSimffspiine

| SPROJ_DIRS/ra/fspiine/api
|$PROU_DIRS/raffep/inciinstances

| SPROJ_DIRS/ra_cfg/fsp_cfg M
_Piaiﬂada file:

Defined symbols: (one per line) =

| || Preprocessor output to file

Presene comments
Generate #ine directives

Category:
General Options
M ge_gen
L—E [ buildinfo.ipef Make
& Output Compile
Rebuild All Buid Actions
Clean
Debugger
C-STAT Static Analysis Sl
CADL
Stop Build CMSIS DAP
GDB Server
Add T-jet
JLink/}-Trace
Remaove T1 Steliaris
Rename.. MNu-Link
PE micro
Version Control System ST-LINK
————————— Third-Party Driver
| |AR_QECapT ouchE wam) Open Containing Folder.. TI MSP-FET
Buid File Properties.. TIXDS
Messages Set as Active
systern c

ok ] coea

Figure 50. Open Project Option
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5. Click on the empty row and add the ge_gen folder to the list of include directories. The triangle button
can be used to change the absolute path to a relative path. Click OK to close the dialog.

Edit Include Directories K

Includs diectory A .Ei EE
$PROJ_DIR$/ra_clg/fsp_clg

$PROJ_DIR$Aa_clg/fsp_clg/bsp
$PROJ_DIRS/a_gen

Dama

-T H— I UINTIV_ T BTTOT_LateoTsu_Cre W
S - wint1é t valueCTSU CFG NIM CF

Figure 51. Add ge_gen To List Of Include Directories
6. Right-click on the project and select Rebuild All. The project should be built without error.

File Edit View Project J-link Tools Window Help

AN - B[4
Debug w
Files &

=L JIAR_QECapTouchExample - ... | v |
M Flex Software
M e_gen

— D buildinta.ipct
B Output

14R_QECapT ouchE xample

Build - 0 X
b 1= File Line ~
Total number of Brrars: 1]
Build succeeded

Build  Debug Log

Ready Errors 0, Warni & Ln & Col 1 System CAP NUM OVR 5 a8

Figure 52. Build Successfully
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7. Run Capacitive Touch Project in IAR EWARM

1. USB connection for power:

Connect CN5 on RSSK-RA2L1 board to the USB port of the host PC using the USB cable.

2. Debugger connection:

Connect the debugger cable from the Debugger port (J1) of RSSK-RA2L1 board to the J-Link. Connect

the other side of J-Link to the host PC using a USB cable.

The picture below shows the connection between the host PC and the RSSK-RA2L1 board.

CN5
Connect to USB
port of PC

Connect to
USB port of PC

A UR AR LLARRRARARRN Taaprnist

A
“i

Arwbrshire i axh

Figure 53. Connection Between PC & RSSK-RA2L1 Board

3. Right-click on the project and select Options....

Workspace v X

Debug

rctsuh X qe_touch_c

typedef struct

=

E
i

ge_touch_config.c

“— &) ge_touch_define.t
—— D buildinfo.ipcf

= Clean
B Output

Files O -

Bl JIAR_QEC —

W Flex Software Options..
) Mge_gen Make

— ) ge_touch_config.h Compile
Rebuild All

Figure 54. Open Project Option
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4. Inthe Options dialog, select Debugger > Setup. Click on the Driver menu to select J-Link/J-Trace.
Click OK to save the settings.

Options for node "IAR_CQECapTouchExample”

Category:

General Options

Static Analysis

Runtime Checking
C/C++ Compiler
Assembler
Qutput Conwerter
Custom Build
Build Actions
Linker

Simulator

CADIL

CMSIS DAP

GDE Server

I§et

J-ink{1-Trace

TI Stellaris

Mu-Link

PE micro

ST-LINE

Third-Party Driver

T macn e

Crrivar

ownload Images  Multicore Estra Options  Plugins

Hun to

J-LinksJ-Trace w | main

Simulator
CaDl

Fu—Link
FE micro
ST-LIMK

Tl D5

ChiSIS DAR
GLE Servar

ellarz

Third-Party Driver
Tl MSP-FET

Factory Settings

prdebupeer¥Rene sas¥RTFAZLL AD ddf

Cancel

5. Click Project, select Download and Debug.

Figure 55. Setting Project Option

File Edit View

Project § J-Link Tools

Window Help

D M k& @ [ Le AddFiles..
Workspace [® Add Group..
Debug L*|| Import File List...
Fil Add Project Connection...
les
= ‘ AR QEC. Edit Configurations...
| sl
-: Flex Softy Remove
M ge_gen
F— Dlbuildinfo{ ©J | Create New Project...

B Output

ke

o

@006

Add Existing Project...
Options...
Version Control System

Make
Compile
Rebuild All
Clean

Batch build...
Clean Browse Information
C-STAT Static Analysis

Stop Build

Alt=F7

F7
Ctrl=F7

F&

Ctrl+Break

Download and Debug

Ctrl=D

Debug without Downloading

Attach to Running Target

Figure 56. Download & Debug Project
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6. The Disassembly window will pop up and the project should run smoothly.

File Edit View Project Debug Disassembly J-link Tools Window Help
NN B = XEG O C < Q>8=E<P O AO=6GCcO (0 Ci T
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Debug - Rese’r_Handler() fiy Goto:| V| Zone: | Mk
. void Default Handler(void); ~ . o
Files i+ int32_t main(void); Disassembly
B @IAR_QECapTouc... + i
B Flex Software / Reset_Handler:
-'qe gen * MCU starts executing here out of reset. O==90: 0=xb5&0 FUSH
F— O bwildinfo.ipcf ) ) SystemInit();
L@ & Output - ‘E‘”d Reset_Handler (void) 0x=92: Dx£000 0x£805 BL
S* Initialize system using BSP. */ mEdal)
SystemInit(); Oxe96: 0=f000 O=f8b7 EL
while (1)
/* Call user agpplication. */ ??Reset_Handler 0:
main();
BSP_CFG_HANDLE UNRECOVERAELE ERRCR(!
»[—] Default_Handler:
/* Infinite Loop. */ , Oze9c: Oxhel0 BEFT
Food
Ly Ozefe: 0=4770 BX
void Sy=temlnit (void)
/ i
* Default exception handler. Systenlnit:
v
|14R_QECapT ouchE xample < > v|e foomo e fetran e >

Figure 57. Run Project
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Renesas RA Family QE for Capacitive Touch usage for IAR EWARM

Website and Support

Visit the following vanity URLSs to learn about key elements of the RA family, download components and
related documentation, and get support.

RA Product Information www.renesas.com/ra

RA Product Support Forum www.renesas.com/ra/forum

RA Flexible Software Package www.renesas.com/FSP

Renesas Support WwWw.renesas.com/support
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Revision History

Description
Rev. Date Page Summary
1.00 Feb.25.21 — First release document
1 Update to Operating Environment
— Changed version FSP to v3.5.0
1.10 Jan.25.22 — Changed version QE for Capacitive Touch to v3.0.1
4,27, 28 Changed debugger to J-Link
10 Added Setup Configuration
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1.

Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
Input of signal during power-off state

Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi (Min.).
Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSI is not guaranteed.
Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a

system-evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product's quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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